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UNDERSTANDING A DATABASE

A database or an electronic database refers to an organized collection of data stored on a
computer in such a way that its contents can be quickly accessed, updated and queried with
the help of a software program.

A database usually contains data pertaining to one particular entity or organization. For
example, the database of a particular school contains data about its students, their academic
co-curricular achievements, details of teachers and other administrative staff, and so on.
Similarly, the database of a library contains data about all its books, members, its various
other activities, and so on.

DATABASE MANAGEMENT SYSTEM (DBMS)

The software program that allows us to create, access, update and query a database is known
as a Database Management System or DBMS. Using a DBMS we can access and modify the
data in a database, query the database to view a particular set of data, print the data in a pre-
defined format and perform many other useful manipulations on the data.

In simple words we can say that Database Management System allows us to manage a
database. The management of a database involves creating a database, modifying, deleting
and adding datainit.
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Advantages of Usinga DBMS

A computerized Database management System or a DBMS offers several advantages over the
conventional filing systems. Some of these advantages are as follows:

Organized storage of Data : The Database Management System allows us to store, retrieve
and process a collection of data in a central database file. It eliminates the need of using
different files for the storage of data.

Efficient Information Retrieval : The main task of the Database Management System is
provide the correct information in the required format as and when required. One can use a
query to extract the require data from the database.

Reduces Data Redundancy : In a conventional filing system two or more files may store the
same piece of data. This leads to data duplication or data redundancy, resulting in an
inefficient use of memory space.

In a DBMS, all the data is kept at one central location. The centralization of data ensures that
no unnecessary duplication of data takes place. This leads to reduction in the total amount of
data (that, otherwise, is bloated due to redundant entries), and a better and more efficient use
of memory space.

Improves Data Consistency : Data consistency, here, refers to the lack of contracdiction in the
data. Since all the data in a database is kept at one central location, any changes made to a
particular data item are, immediately, reflected across the whole database. This reduces the
chances of data being changed in one file and remaining unchanged in some other file, thus
improving the overall consistency of data.

Data Sharing and Protection : The DNMS allows sharing of the centralized database by
many users. The DBMS makes sure that only authorized access is given to the database. This
keeps the data confidential and secures it from unauthorized access.

Maintains Data Integrity : Since the same database is being shared by many users, an
important job of the DBMS is to see that data, which is being transmitted to or received from
several users does not get corrupted. In other words it maintains data integrity.
Standardization of Data : The use of DBMS allows the entry of data in a standard format
using its data validation feature. This make sure no one enters a wrong type of data in a
database that may, later, lead to problems.

RELATIONAL DATABASE MANAGEMENT SYSTEM (RDBMS)

A relational database is a special type of database where data is stored in a
number of separate, but linked tables. The software system that is used to
create, maintain and query a relational database is called a Relational
Database Management System or RDBMS.

MS Access — An RDBMS
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In arelational database two tables are linked together using a common field or column, When
a user makes a query, the RDBMS, temporarily, combines the data in the related tables and
presentsitin the form of a query table to the user.

Each relational database may consist of a number of tables. Each table has a number of
records. Eachrecord is made up of many fields and each field can contain many data entries.

————— A, :
A0 IR'(1]Fz:" The concept of Relational database was given by E.F. Code at IBM. There are many RDBMS :

fKNOW? E available. Some of them are Oracle, foxPro, and Microsoft Access. :
e .

DIFFERENT DATABASE OBJECTS

A database contains a specific structure to store data. Following are some basic terminologies
used in a database that will help us in getting acquainted with the functioning of a DBMS::
Tables, Queries, Forms and Reports.

Table
ATable is a database object that stores data in the form of records (rows) and fields (columns).
It is the building block of a database. All other elements of a database are created based on the

data stored in the tables. The basic components of a table are shown in the picture given below:
Field

Record

Data Item

Cell

Records: The rows in a table are called records. Record is a collection of related fields that
contain complete information about an entity in a table. For example, in the above table each
record is a collection of information about one particular student such as his ID, Name and
class.

Fields: Fields are different columns within a table. Each field in the above table contains the
same type of information for each student such as their ID, Student Name, Class, and so on.
Cell: Atable can be viewed as a collection of several rectangular boxes known as Cells. All the
data in a table is entered into its different cells. Each data entry in a cell of a table is called a
Data Item.

Querie
A Query is a database object that gives out a selective output based on certain criteria or
conditions in the form of a query table. Queries are always based on tables and other queries.
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Form

AForm is an interactive graphical object of a database that allows the user to enter, edit and
view records from a table or query table. A form focuses on one record at a time, i.e., it
displays only a single record from a table or a query table, at a time. A Form is always based
on a table or query table. Data entered through a form is stored in the table based on which it
is created.

Report

A Report is a database element that allows users to present information from a table or a
query in a formatted, printable manner. Reports in a database can be created either in the
Design view or using the Report Wizard.

Field Data Types

A table stores various types of data. The data entry varies according to the types field in a
table. The following table explains various data types that are commonly assigned to the
fieldsinatable:

Text Itis used to store short text and data like names and addresses  Upto 255 characters
that may be formed of the combination of letters, numbers,
spaces and special characters.

Memo Itis used to store long textual messages, commentsornotes.  Upto 65,535 characters

Number Itis used to sore numeric values like distance, salary, quantity ~8bytes
sold or purchased and so on.

Date/Time It is used to store date and time values like Date_of_birth or 8bytes
Date_of_joining, and so on.

Currency It is used to store currency values like rates, prices, and soon. 8bytes
A currency symbol ($) automatically appears before each
value entered in this field.

Autonumber = Thisis used when you want a sequential series of numbersto  8bytes
be generated automatically. The initial value is 1 and the value
isincremented by 1 with each record.

Yes/No This is a logical data type and is used for storing Yes/No, 4bytes
True/False or On/Off values.
Attachment This data type is used for storing filessuch asanimagefileina 4bytes
field.
MICROSOFT ACCESS 2010

MS Access 2010 is the most popular and powerful Relational Database Management System
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(RDBMS) that comes as an integral part of the MS Office 2010 suite of
applications. It is a powerful GUI based RDBMS using which we can create
customized databases for self-use or for use by small and medium sized
businesses. It enables them to store, manage and utilize their data in an
efficient manner.

M@ ______________________________________________________________________________________________________________________ \:

4
’?ﬁoyﬁp E Theinitial code name of MS Access was Cirrus.

STARTING WITH MICROSOFT ACCESS 2010

We can start MS Access 2010 by typing 'Microsoft Access 2010' in the Search box on the Start
screen and then pressing the Enter key.

...The opening screen of the Microsoft Access will appear with New Backstage view active.
This opening screen gives us a number of options to create a new database using various
readymade templates. The steps to create a new database using the New Backstage view are
as follows:

Blank database
template

1. Click onany template listed in the right pane. Here we are selecting the Blank Database
template as we want to create a blank database.

2. Click on the Folder icon to choose the location where you want to create the database
file.

3. Enteraname for your database.

4. Click on Create button.
...The new database with the given name gets created and opens in the MS Access
window.

Remember

B Adatabase file created in MS Access 2010 has an extension of .accdb.
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Components of the Database Window

Once we have created a database file, it will be displayed on the screen in the form of a
database window, with components as shown below :

Title bar : Appears at the top of the program window and displays the name of the database
and the program.

Quick Access toolbar : Appears on the left side of the Title bar and contains the frequently
used commands that are independent of the tabs displayed on the Ribbon.

Quick Access Toolbar Title bar

Ribbon

Document
Tabs Bar

Navigation Pane

Object window

Record
Status Bar Navigation Bar

Ribbon : Extends across the top of the program window, directly below the Title bar and
consists of a set of tabs, each of which contains groups of related command buttons.

Navigation pane : It appears on the left side of the program window and displays a list of all
the objects in a database. You can click on the () button to hide and on the () button to
show the navigation pane.

Object window : It appears below the Ribbon and displays the open database objects.
Document Tabs bar : It appears at the top of the object window. All open objects are
displayed on this bar. To view an object, click its tab. Click the Close button on the right edge
of the bar to close the currently selected tab.

Status bar : It appears at the bottom of the program window and displays information about
the database and provides access to certain program functions.

Record Navigation bar : This bar is located at the bottom of the object window and allows
you tonavigate records one at a time. You can move to the next record, previous record, first
record or last record by clicking on their respective icons on the navigation bar.

New Record

First Record ——
Previous Record Next Record Last Record

o008
o B

@

v o} ('[‘3

Icon-X-8



Ml Activity

Tick (v') the correct answer in the D .

1.

Which of these is a database management system?

a. MS Excel D b. MSWord D c. MSAccess
Which of these is not a feature of a DBMS?

a. Data consistency D b. Data security D c. Dataduplication
Which of these is the file extension of a file created in MS Access 20107

a. .accdb D b. .acxmb D c. .amdb

Which of these is not a part of MS Access database window?

a. Ribbon D b. Module D c. Navigation pane
From where can you access database objects in a database file?

a. Navigation pane D b. Design pane D c. Createtab

O 0O O O

DATABASE VIEWS IN MS ACCESS

MS Access allows us to create and edit tables and other database
objects in two main views. These are called Datasheet view and

Design view.

= Datasheet view : In Datasheet view tables are seen exactly the
way they are. We generally use the Datasheet view for
creating tables, entering data into them and also for editing

data.

= Design view : The Design view is useful to specify the design
(field names, their data types and field properties) of a table or
tomodity the design of an existing table.

How to change the View?

Follow these steps to change the view :

Tables Views in Access

1. Select the table whose view you want to change in the Navigation pane and click on the

Home tab.

Table in Data Sheet View
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Table in Design View

2. Click the down-arrow under the View button.
3. Inthe drop down menu, click the View you want. ... The table will be displayed in the
selected view.

T'P! You can also change to the required view by right clicking on a table icon in the Navigation pane (left pane) and
selecting the desired view from the shortcut menu.

CREATING TABLES IN A DATABASE

When we create a blank new database, a new table named Tablel is created automatically
and opens in the datasheet view. However, we can also create new tables either in the
Datasheet view or in the Design view. Let us learnhow to doit.

Creating a Table in the Datasheet View

The steps to create a table in the datasheet view are as follows:
1. Opentherequired database and click on the Create button.
2. From the Tables group select the Table command button.

Select a data type for the field

...A new table will appear in the database window with two fields. By default, the
word Click to Add will appear in the column header of the blank second field.
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3. Click on the Columnheader.

...Adrop downlist of data types will appear.

4. Selectadatatypebased on the kind of data you want to enter into the field.

5. Double click on the Column header and type out a name for the new field. You can also
rename a field by right clicking on the Column header (field name) and then selecting
the Rename option from the shortcut menu.

6. Inasimilar way, add more fields on the table and rename them as required.

7. To save the table, click on the Save button on the Quick Access toolbar. ...The Save As
dialogbox appears.

Table Mame:

|511.IC|EFI1II

Saving the Table

a. Type a name for the table in the Table Name box. (Here we name the table as
'Student'.)
b. Click onthe OKbutton. ... The table will be saved by the givenname.
8. You cannow add data to the table by clicking in the different cells and typing out data
entries in the different fields one-by-one.

9. After adding data, click on the Save button on the Quick Access toolbar to save the

changesmade to the table.

. Entering data into the table
...The changes will be saved. ring datat

A

i[ ;) | Remember

¥ Notice that when a table is created two contextual tabs — Fields and Table appear on the ribbon under the heading
Table Tools. The Fields tab contains options to work with fields of the table and the Table tab contains options to
set the table properties and relationships.
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Working with the Table in the Design View
Though MS Access 2010 allows us to set field data types and properties in the Datasheet View
itself, itis always best to set these attributes in the Design view. Let us create another table and
learn to set data types for its various fields in the Design view.

1. Click onthe Create tab, select the Table button from the Tables group.

Saving the table by the name 'Marks Table'

...The empty table structure layout will open in the datasheet view.

2. Click on the Design View button on the ribbon.
...The Save As dialog box opens.

3. Giveaname to the Table and click on the OK button.
...You will see one field with the field name “ID” automatically inserted with the Auto
Number type.

4. You can click in the cell below the ID field and type the name of the new field (here,
Student_Name) and press the Enter key.

Setting data type for the fields in Design View
...The cursor will shift to the Data Type column.



5. Select the data type for the field.

6. Add adescription about the field in the Description column, if required.

7. Similarly define other fields, their data types in the Design view and click on the Save
button to save the changes made to the table design.
We cannow view the table in the datasheet view and add data to it as required.

Entering data to the table in datasheet view

DEFINING A PRIMARY KEY

A Primary key is a field that uniquely identifies a record in a table. For example, in our table
Stu_ID is a primary key field as it has a unique value for every record. To set a primary key,

follow the steps given below :

ﬂ Remember

® A primary key does not allow Null values and must always have a unique value.

1. Open the Home tab and click on the down arrow of the View command in the Views
group.
2. From the list of views select Design view. You can also click on the Design view button
from the status bar to switch over to the Design view.
3. Select the field name Stud_ID.
4. Click onthe Primary key button, in the Tools group of the Design tab.
...Akey mark will appear in front of the field name showing that it has been set as the
primary key field.
We can now save the changes made to the table by clicking the Save button on the Quick
Access toolbar. Switch over to the datasheet view to add data to the table or edit the data it
contains.

T'P! The Primary key is a toggle key. To remove the primary key property from a field select that field and click on
the primary key button.
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Primary Key
button in
Design Tab

Selected field
ADDING NEW RECORDS TO A TABLE

The steps to add anew record to an existing table are as follows:
1. Open therequired table (to which you want to add records) in the datasheet view.

2. Inthe Records group on the Home tab, click the New button Or, click the New Record
button on the Record Navigation bar.

New Record Button

Click to enter another record New record entered

... This will place the cursor in the NEW record below your lastadded record.
3. You can also simply click in the NEW record row (which is below your last added
record) and start typing data to add anew record to a table.

4. After entering the records, save them by clicking on the Home tab and then selecting
the Save command button from the Records group.

5. You can also format the data in a table by clicking on the various command buttons
givenin the Text Formatting group on the Home tab.

EDITING AND DELETING RECORDS

Editing Records
To quickly edit any record within a table, follow these steps:
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1. Clickin the cell containing the data that you want to edit or change.

2. Delete the existing data using the Backspace or Delete keys and type the new data as
required. A pencilicon ([¢]) appears to indicate the Edit mode.

3. Savethe changesby clicking on the Save button in the Records group on the Home tab.

This icon shows that the record is being edited. Editing a record by changing a data entry
Similarly, make corrections to the data given in the other cells/records as required.

Deleting Records
The steps to delete arecord from a table are as follows:
1. Select the entire record by clicking the gray border (known as the Record Selector) on
the left side of the record.
2. Selectthe Home tab, and locate the Records group.
3. Click the Delete command button.

Delete button in the Records group

...Therecord will be permanently deleted.
MODIFYING THE TABLE DESIGN

We can modify a table's design in both the Datasheet view and the Design view. Here we will
learn to modify the design of a table in the Datasheet view.
MovingaField
To change the position of a field or to move a field, follow the steps given below :
1. Select the field that you want to move. Take the pointer to the bottom border of the



field'sheader cell. The pointer will change shape to moveicon (+}-).

2. Click and drag left or right in the desired direction. ...While dragging, a vertical line
will guide you.
3. Once the vertical lineis positioned at the desired location, release the mouse button.
...The selected field will move to new position in the table.
Inserting a Field
Toinsertafield, follow the steps given below:
1. Right-click on the header cell of the field before which you want to insert a field.
2. Inthe shortcut menu that appears select the Insert Field option. ... A new field will be
inserted.
3. Change thename of this field as you want and add data to it as required.
RenamingaField
Torename a field name, follow the steps given below:
1. Take the mouse pointer to a header cell of field that you want to rename and right click
onit.
2. From the shortcut menu select the Rename Field option. The field name will become
highlighted.
3. Enter anew name to replace the highlighted field name and press the Enter key.
Deleting a Field
To deleted a field from a table, follow the steps given below :
1. Right-click on the header of the required field and select the Delete Field option from
the shortcut menu.
OR
Select the required field and click on the Delete button in the Add & Delete group on
the Field tab.
2. In the dialog box that appears click on the Yes button to permanently delete the

selected field.

Changing the Width of a column

To change the width of a column, follow the steps given below :

1.

Click anywhere in the field whose width to be changed.

Drag left or right to change field width
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2. Take the mouse pointer on the left or right border of the field header. ...The mouse
pointer changes into a horizontal double arrow crossed by a vertical line (—-).
3. Ifyoudouble-click now, the column would be resized to the widest possible size of that

type.

OR
Click and drag the mouse in the desired direction, left or right, until you get the desired
width.

Changing the Data Type of a Field
To change the data type of a field, follow the steps given below :
1. Click onthe field whose data type you want to change.

Select the required data type

2. Click on the drop down arrow of the Data Type option in the Formatting group under
the Fields tab and click on the required data type.

...The data type of the field will change.
A
g | Remember

¥ To go to a specific record in Datasheet view, press Alt+F5 keys. The cursor will appear in the Current Record
box. Type the record number and Press the Enter key.

SORTING DATA IN ATABLE

We can sort data alphabetically or arrange numbers in ascending or descending order. To sort
data, follow the steps given below :
1. Click on the drop down arrow on the right of the field name you want to sort.

Sorting options for a Number Field
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2. Click on the sorting options displayed.
(Remember, sorting options will be different for fields having different data types)
...The records will be sorted in the order as per your selection. A small upward /
downward arrow will also appear in the sorted field name.
OR
Click on the Ascending/Descending option in the Sort & Filter group under the Home
tab.

T'P! To undo the sort, click on the Remove Sort option in the Sort & Filter group under the Home tab.

@
A
° =

1=

= A database is an organized collection of data stored on a computer in such a way that it can be
easily accessed, updated and queried with the help of a software program.

= The software program which allows you to create, access, update and query a database is known
as the Database Management System or DBMS.

= A Relational Database is a type of database where data is stored in a number of separate but
related tables. The software that allows you to create and manage a relational database is called a
Relational Database Management System (RDBMS).

= MSAccess 2010 is a Relational Database Management System.

= Tables, Forms, Queries and Reports are the main objects of a database.

= Thetype of data that a field (in a table) can store is called its data type.

= Tableisthe main object of a database. All data in a database is stored in tables.

= Tables can be created in both the Datasheet View and Design View. Data can be entered into a
table in the Datasheet View.

® APrimary key is a field that uniquely identifies each record in a table.

J

= Database :An organized collection of data stored on computer that can be accessed,
updated and queried with a DBMS software.

m DBMS : Database Management System is a software used to create and manage a
database.

= RDBMS . A special type of database management system where data is stored in related
tables.

m Table :  The main object of MS Access database where actual data is stored.

m Primarykey : Afieldthatuniquely identifies every record in a table.
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( E'CHAPTER

Check-Up

A. Tick (V') the correct answer.

1.

1.
2.
3.

ooR

Arow of information in a table is called a
a. Record b. Field c. Value
A column of informationin a table is called a
a. Dataitem b. Record c. Field
Which icon indicates the Edit mode in MS Acess?
a. Pencil b. Eraser c. Pen
A primary key does notallow ______ values.
a. Zero b. Null c.  Numeric
While designingatable_ fieldis optional.
a. Field Name b. DataType c. Description
B. Fillinthe blanks with the help of given hints.
A is a software that handles the various operations associated with a database.
software stores data in the form of multiple tables that are related to each other.
Four objects in a MS Access database are , , and
A field containing names will most probably be assigned a data type.
A data type is used to store long textual message, comments or notes.
A is a field that uniquely identifies a record in a table.

HINTS : Tables, DBMS, Text, Memo, RDBMS, PrimaryKey, Queries, Forms, Reports

C. Write 'T' for True statements and 'F' for False statements in the D .

N OO U N W R

The primary key identifies each record in a table uniquely.
A columnin an Access table is called a field.
The primary key button is available on the design tab.

A number data type can store only integer values.

DBMS stands for Data and Business Management Software.

You can add data to a table in the Design view.

Reports are used to display selected data in a printable format.
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Match the following.

1. Field a. Rectangulararea where data is entered.

2. Record b. A column containing a particular type of
informationin atable.

3. Cell c. Adataentry madeinto a cell.

4. Table d. Acomplete row of information in a table.

5. Dataltem e. Agridof cells.

Very Short Answer Questions.
1. Whatisdataiteminatable?

2. Name the Database views in MS Access.

3. Whichis known as Toggle key in MS Access?

Short Answer Questions.
1. Write the full form of RDBMS.

2. WhatisaRecord?

3. What do you mean by the Primary key?

Long Answer Questions.
1. Define the following terms:
Table

Data

Record

2. What do you understand by a database? Give some examples of database.

3. Whatare the advantages of databases?
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Practical 1 : Create a table with the given fields. Enter 10 records in it. Save the data base with the name

Student_Result.

Field Name | Admin.No | Name English | Maths Science | SST Percentage | Rank

Data Type | Text Text Number | Number | Number | Number | Text Text

e

Create a table and enter 10 records in it.

Make changes in this table. Rename the field name 'Name'to student_name'.

Set Admin-No as the 'Primary key.

Insert a new field 'Total' before the percentage.

Edit records from the rows 4 to 7 replacing their information with the new values.
Delete the first two records.

Sort the records in an ascending order.

Save the table and exit Microsoft Access.

Practical 2 : Create another table with the given fields. Enter the records in it. Save the database with the

name Student_Details.

Field Name | Admin_No.| DOB Name Fathers_Name | Address Contact_No | Age

Datatype | Text Text Text Text Text Number Number

Create a table and enter 10 records in it.

Modify the table and insert the field Name 'Roll No' after the field 'Admin-No'".
Set Roll_No as the Primary key.

Insert new field, 'Mother's_Name' after the 'Father's_Name'.

Add two more records at the end of the table.

Delete the record number 6.

Save the table and Exit Microsoft Access.
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